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INTRODUCTION

The ShowTracker Integrated Solution for Theatrical Sound Design is a
comprehensive relational database designed on, and for use on, FileMaker, Inc.’s
FileMaker Pro™ application.  The solution is designed to aid sound designers,
production sound engineers, and assistant sound designers in the creation and
maintenance of paperwork associated with a typical Broadway or West End
production.

ShowTracker records information on a per-show basis, tracking master
equipment lists, sound effects, cables and bundles, RF microphones, mixing
console set-ups and settings, equipment settings, notes, staffing, boxes and
manifests, and various other features via twelve interconnected files.  Templates
and scripts abound in order to effectively produce clear lists, data sheets, and
printed labels for just about any facet of the Sound Design.

Many designers and engineers have constructed their own templates in database
and spreadsheet applications.  Our intent is produce a solution that is as globally
applicable as possible.  This solution has been developed over the better part of
eight years in the hopes that we can offer this software as a viable solution to the
never ending— and constantly changing— stack of paperwork.  Why repeat
data-entry commands in different applications just to change the length of a
bundle?  Why waste expensive labeling tape on cables and fanouts when
standard address labels can be fed en masse into a printer?  Why scratch your
multi-million dollar mixing desk with pencil markings when you can track all
the knob positions on the computer?  What about maintaining consistency
between different companies of the same show, or tracking the origin of certain
sound effects?

Because ShowTracker is written in FileMaker Pro™, ShowTracker is completely
cross-platform.  Platform-specific layouts and scripts do exist when a universal
template does not produce desired results.

Please note, however, that the FileMaker Pro™ application is not included with
ShowTracker; the solution is merely a collection of files with predetermined
layouts, templates, fields, and scripts.  A basic understanding of relational
database structure is advisable to fully utilize the features within.  This Guide
will attempt to provide some basic FileMaker Pro™ tips and tricks.

ShowTracker is and always will be a work-in-progress.  Every attempt is made to
ensure that all functions work properly on any computer system with any printer
combination, but mistakes are made.  It is therefore imperative that any and all
bugs, issues, confusions, slings, and arrows are reported to the developer.  If
there are any specific features that do not currently exist, tell them to the
developer as well.  ShowTracker can only improve with feedback (ha ha) from
actual users.
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DATABASE BASICS (DATABASICS?)

In its simplest form, a database is defined as a collection of related data arranged
for ease and speed of search and retrieval.  Databases are everywhere— your
address book, your calendar, your doctor’s patient histories, your library, the
computer system that automatically sends you pleas for more money from your
alma mater— and they are very easy to understand.

A simple database may be a single file— for instance, an address book.  This file
has a set of fields, which are places in which data is stored.  In our example, we
would have fields such as “First Name,” “Last Name,” and “Telephone
Number.”  They are merely containers in which the user can store information,
and are completely empty until the user starts to add data into these fields.

Information is stored in records, which are akin to the cards in your Rolodex or
the actual entries in your address book.  One record may have the datum “John”
in the “First Name” field, then “Meyer” in the “Last Name“ field, and “510-555-
1234” in the “Telephone Number” field; other records are stored in exactly the
same way within the database.  Pretty simple, eh?

When you start linking different databases together using the data within, they
are collectively appellated a relational database.  Let us assume that in addition
to your address book, you have a day-planner.  In the day planner, you schedule
a lunch with John Meyer.  You want to write his phone number in your day
planner, underneath your appointment.  You could manually look it up and then
re-enter it, but an easier method is to link certain fields together.  For instance,
you would tell your day-planner to create a relationship between the First Name
- Last Name combination of “John Meyer” in your day-planner with the First
Name - Last Name combination of “John Meyer” in your address book.  If you
enter a name in your day-planner and it matches a record in your address book,
the data from your address book can be displayed in your day-planner
automatically.  So, if you have another lunch date with “Britney Spears” listed in
your day-planner (and hey, who doesn’t?), so long as “Britney Spears” appears
in your address book, her other information (address, telephone number) can
appear in your day-planner automatically.  This relational database system is at
the crux of most database solutions, including ShowTracker.

Fields can be defined by the developer to only contain certain types of input; in
your address book, for instance, the “Telephone Number” field may be restricted
to only allow numerical values, so typing “Stronger” into the “Telephone
Number” field will produce an error.  Dates, Times, Numbers, Text, or even
pictures are all different field types.  In addition, fields may be defined as
calculation fields, which take data in a different field, process it in some way,
and produce an output.  These obviously cannot be modified directly, as they are
dependent fields.  Defining a field called “Area Code,” we can tell the database
to look at the first three numbers of the “Telephone Number” field and spit out
its result.  If you change the telephone number, the area code changes as well.
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Databases also have an almost unlimited number of methods by which you can
view, organize, and search your data.  Fields are viewed on layouts, which are
templates that physically orient your fields in easy-to-use ways for data-entry,
list-viewing, or label-printing applications.  Not all fields need to appear on each
layout, which makes customizing a solution very simple.  Records can also be
sorted in specific ways— alphabetically, by birthday, by state, by pet’s name—
thus providing even more options for viewing the data.

Scripts are one of the most powerful features of a database solution.  Simply put,
scripts— like macros— are a collection of commands that act upon the data in the
file and the file itself in a predetermined way, either to produce new data or to
organize the data in a consistent way.  The content of the file is unimportant; the
actions are carried out in exactly the same manner regardless of the data (unless
told otherwise).  Using our address book example, we could trigger a script that
would take the current record and copy all the information to the clipboard for
use in another file.  Or we could have the computer dial the telephone number
for you.  Or print a single address label.  Or sort through all the records and find
anyone whose birthday is in February.

These are the basic constructs of a database solution: in each file there are fields,
which contain data.  Fields are viewed on layouts and can be sorted.  Scripts
allow repetitive tasks to be built into the solution.  Fields can also be used to link
one file with another in a relationship.  Some people say I’m no good with
relationships, but they obviously haven’t seen ShowTracker.

Now, on to more specifics!
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FILEMAKER PRO™ BASICS

FileMaker Pro™ is an incredibly powerful program, and relatively simple to use.
Upon opening a file, this is what we see:

The strip of FileMaker Pro greyness at the left-hand side of an active window is
called the status area.  At the top left corner is the Layout Menu, which, when
clicked-and-held, provides a list of layouts available to the user.  The user can
change the layout in any of the three active modes to view your data in different
ways.  Underneath the Layout Menu is the index card stack, which displays the
current state of the file.  In Browse mode, the number will indicate the current
record being browsed, and underneath will display the total number of records,
or the current number of records in the found set.  In Find mode, the index card
stack will indicate how many different search queries have been entered.  In
Preview mode, the stack will indicate number of pages required for printing.
Sometimes a “?” will appear, and this indicates that FileMaker has not bothered
to figure out how many total pages are required until the user thumbs through
the index card stack to the last page.

At the bottom of the status bar is the Zoom box, which should be self-
explanatory.  The next button toggles the status area on and off.  By default,
ShowTracker should maintain the status area ON.  Next is the Mode Menu,
which indicates which mode is currently active.  Clicking-and-holding will
display the other options.

There are four modes to the program: Browse, Find, Layout, and Preview.  For
data-entry applications, the user must be in Browse mode.  This allows the user
to add new records, edit existing records, and step through records.  In Find
mode, the application will take whatever layout it is currently using and enable
the user to enter search criteria in any of the active fields.  Once the Find has been
enabled, the application will switch back to the Browse mode.  Layout mode is
disabled in the release version of ShowTracker.  Preview mode allows the user to
see what a printout of the current layout will look like.  Data entry and/or
modification is not allowed in this mode.

The menu bar of FileMaker Pro™ is pretty self-explanatory.  The File menu
contains most of the commands one would expect to see in a File menu.  The
important ones are, of course, “Open,” “Page Setup,” and “Print.”  Some File
menu options will be disabled with the release version of ShowTracker.  Sorry.
The Edit menu works within records; with no field selected, “Copy” will simply
copy all of the active field data within the record in a big clump.  It is pretty
useless.  Further along the Edit menu, spellcheck is by default turned off, because
users should know how to spell properly by now.  In the View menu, we see the
mode listing and various other options that you can toggle to your heart’s
content.  The Insert menu provides a few options which can be automatically,
well, inserted into an active field, such as current date, time, or user name.
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Format is, as the name implies, for text formatting.  The Records menu contains
the important bits to working on a database— new records, duplicate records,
delete records, etc., etc.  Most of these commands are covered below, in the
“shortcuts” section.  The Scripts menu is deactivated in the release version of
ShowTracker, the Window menu is self-explanatory, and the Help menu
provides users with both FileMaker Pro and ShowTracker help options.

Here are some keyboard tips and shortcuts:

(Macintosh users note that -B is equivalent to the keystroke command-B; in the
Windows world, -B is equivalent to control-B)

-B: Browse mode.  This will enable the user to enter and modify data.
-F: Find mode.  This allows the user to perform a search.
-L: Layout mode.  Disabled.
-U: Preview mode.  This is for previewing what the current layout

will look like when it is printed.

-N: New record.  Creates a new record.  Essential for starting a new
project.

-D: Duplicate record.  In currently selected record, will duplicate all
field contents to a new record.

-E: Delete record.  Deletes the currently selected record.
   shift--E: Delete multiple records.  Prompts the user for a number of

records and then deletes them.
-T: Omit record.  Simply “hides” the current record from view, but

does not actually delete it.
   shift--T: Omit multiple records.  Prompts the user for a number of records

and then hides them.
-J: Show all records.  After performing a search, or after omitting

records, this command will restore all records to view.
-S: Sort records.  Prompts the user for sort criteria and then sorts

the available records.

-I: Insert From Index.  In browse mode, using this command while in
an active field will display a small dialog box containing all the
data from other records for that particular field, which can then be
used in the current record.

-': Insert From Last Record.  In browse mode, using this command
while in an active field will copy the data from the previous record
into the current record.

-O: Opens a file.  Duh.
-P: Prints.  Duh.

control-⇑: Previous record.  When in Browse mode, the previous record will 
be accessed.  When in Find mode, the previous search string will be
recalled.  When in Preview mode, the previous page will be
displayed.
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control-⇓: Next record.  When in Browse mode, the next record will be
accessed.  In Find mode, the next search string will be recalled.  In
Preview mode, the next page will be displayed.

tab: Next field.  Conversely, shift-tab is Previous Field.
This is possibly the most important key to remember.  Tab.

Note that [ENTER] and [RETURN] are not always synchronous:

In Browse mode, when in an active field, pressing [ENTER] will exit all
fields, while [RETURN] will act as a carriage-return within the field.

In Find mode, pressing [ENTER] will start the search process, similar to
clicking the FIND button in the status area, while [RETURN] is still a
carriage-return.

When a script is running, pressing [ENTER] OR [RETURN] will continue
the script, synonymous with clicking CONTINUE in the status area.

FileMaker Pro™ will automatically save the file based on its Application
Preferences.  To check what your copy is going to do, follow these instructions:

Macintosh OS X:
FileMaker Pro ⇒ Preferences ⇒ Application
Tab to “Memory” and select your preference: “during idle time,” when
you are not using the file at that moment, or “every xx minutes,” which
will save the file regardless of whether you’re trying to do something or not.

Macintosh OS 9.x:
Edit ⇒ Preferences ⇒ Application
Tab to “Memory” and select your preference: “during idle time,” when
you are not using the file at that moment, or “every xx minutes,” which
will save the file regardless of whether you’re trying to do something or not.

Windows:
I don't remember.
Tab to “Memory” and select your preference: “during idle time,” when
you are not using the file at that moment, or “every xx minutes,” which
will save the file regardless of whether you’re trying to do something or not.
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SHOWTRACKER BASICS

ShowTracker exhibits some salient characteristics.  With this knowledge in mind,
your ShowTracker experience will be simplified.  First and foremost,
ShowTracker solution files should never leave their parent directory.  Although it
is eminently possible to have several different ShowTracker solutions, all with
their own directories, moving a single file from the directory to a different
location will result in VBT— Very Bad Things.

Our advice is to download a fresh copy of ShowTracker, and make this the
“master” copy of ShowTracker.  Simply copy the entire directory and rename the
copied directory with a new name.  This method also ensures that the basic
structure and any required data that exist in a clean copy of ShowTracker
remains intact.

Copying directories of completed shows is also not advisable, but hey— it’s not
our show data.  A better solution is to create a new, blank show in the manner
described above, then import the data from the older shows using the [IMPORT]
button at the top of the Main Menu of each ShowTracker file.  The only exception
to this rule is the (h) Staffing & Contacts file, which can be freely copied to
different shows— just ensure to check that the “Show Name” field reflects the
correct show.

ShowTracker relies on related fields for much of its functionality.  Thus, there is
a vague concept to the order in which the user adds data to the files.  A basic
schematic is shown below, and described in greater detail after that:

(1) Show Information

(2) Mult Summary

(3) Mult Detail(4) Cable & Bundles

(5) Equipment Tracker

(9) Console Settings

(8) Cues & Routing

(6) Equipment Settings

(7) Sound Notes

(a) RF Frequencies

(b) RF Notes

(c) RF Cues

(z) Correspondence

(g) Rack Drawings

(h) Staffing & Contacts

(e) Equipment Library

(i) Payroll

(j) Box Lists

MULT ORDERS
MULT LABELS

CABLE ORDERS
BUNDLE LISTS

MULT TAILS LABELS
AND SHEETS

NOTHING YOU NEED
TO KNOW ABOUT

UHHH, RACK DRAWINGS

BID LISTS
PERISHABLES

REPAIRS/RETURNS

CONSOLE LAYOUTS
CONSOLE LABELS

SETTINGS

FREQUENCY LISTS

RF/ACTOR INFO
TRANSMITTER LABELS
SCENE BREAKDOWNS

CONSOLE CUES
SOUND EFFECTS

BUILD NOTES

RF CUES

NOTES
TO-DO LISTS

SYSTEM SETTINGS
SPEAKER FOCUS

MEASUREMENT MICS

BOX LISTS
TRUCK PACKS

MANIFESTS

SHOW SETTINGS
FILE SYSTEM PREFERENCES

COMMUNICATES TO ALL FILES

MISCELLANEOUS FILES

dd
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(1) Show Information stores basic information about the show; i.e. name,
designer, shop, etc., etc.  Ultimately it does not do a hell of a lot, but it is required
for proper communication between the show files.  It also stores some basic
preferences that globally influence how the rest of the program behaves.  This is
the first file that needs to be used; a script will aid the user in creating a new
show.

(z) Correspondence, (h) Staffing & Contacts, and (i) Payroll can all be used at
any given time; they are not dependent on any other files except for (1) Show
Information.

Similarly, (2) Mult Summary, (5) Equipment Tracker, (9) Console Settings, and
(a) RF Frequencies are first-order files; they are the genesis of the show and are
the first that require data.  Second- and third-order files will refer to them
constantly.  (3) Mult Detail and (4) Cable & Bundles require data from (2) Mult
Summary; (g) Rack Drawings uses data from (5) Equipment Tracker and (3)
Mult Detail; (b) RF Notes uses data from (a) RF Frequencies; (7) Sound Notes,
(8) Cues & Routing, and (c) RF Cues utilize data from (b) RF Notes; and
obviously (j) Box Lists requires data from (g) Rack Drawings, (5) Equipment
Tracker, and (4) Cable & Bundles.

Certain functions within ShowTracker’s files will require input that differs from
the diagram; i.e. (9) Console Settings can be started without (3) Mult Detail, but
labels printed from (9) Console Settings are designed to include the
corresponding mult pair information from (3) Mult Detail.

It all sounds a bit confusing, and it is, but hopefully as we examine each file in
greater detail, everything will become somewhat clearer.  But before we get to
the files themselves, let’s discuss some other salient characteristics:

•Very seldomly do the solution files create new records automatically.
ShowTracker expects the user to use the Entry Layout to begin the data-
entry process, including the creation of new records.  If ShowTracker is
about to create new records of its own volition, it will let the user know
with a warning.

•Very seldomly will the solution files delete records without warning.
If they did such hijinks, we would call them bugs or a glitches.

•The user does not need to open (1) Show Information as the first file.
Simply opening the file the user wishes to use will automatically open
(1) Show Information in the background.

•-1 will always take you back to the Main Menu of the active file.

The Main Menu button looks like this: .
It’s supposed to be a place setting at a table.  With a MENU.  Get it?
In Browse and Find modes, most layouts include a Main Menu button;
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however, in Preview mode, or in layouts without a Main Menu button,
simply clicking -1 will return you to the Main Menu.

•On the topic of buttons, there are a series of buttons that appear in every file:

  - returns to the main menu of the currently active file.

  - goes to the main Entry Layout of the currently active file.

  - performs a search within the currently active file.
note that when a search is performed, the resulting group
of records is called the found set.

  - goes to the Help Menu in (1) Show Information.

  - goes to the Text Entry Layout of the currently active file.

  - performs some sort of list/summary display.

  - imports information from a previous file.

  - quits ShowTracker or FileMaker Pro altogether.

•ShowTracker has a subset of smaller buttons that perform organizational
functions:

  - sorts all found records according to the adjacent field name.
all   - displays all records.
T!   - “tags” all records in the found set.
T?  - finds all “tagged” records in the file.
xT  - clears all “tagged” records in the found set.
C   - clears pertinent data from current record.
V   - displays a pull-down menu of available options.

  - goes to previous record.
  - goes to next record.

s   - “sets” a specific piece of data within a file (more later).

•ShowTracker does a lot.  It is not necessary to use it all.
Some users have criticized that ShowTracker can track too much
information.  This is probably true, but we find it better to err on the side
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of obsessive-compulsive than sloth.  There are certain functions that
the user may never need.  This is okay.  The user should not feel
compelled to use them.

•Use the Quit button to exit ShowTracker.
Often times, ShowTracker files are opened in the background; the Quit
button ensures that all files are closed properly.  It’s supposed to be a sun,
setting over a large body of water, because that’s peaceful and nice, and
signifies the end of the day, and thus, the end of your time with
ShowTracker.  Farewell, gentle user!  Until the ’morrow! I’ll be here, waiting
with bated breath for your next keystroke! ShowTracker is saying in the
background.

Or not.
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(1) Show Information

(1) Show Information tracks some basic information about the show and is the
master file to which all other files in the solution are referenced.  The more
information entered in this file, the more help it may in the future.  The Entry
Layout contains the primary fields that are necessary for optimum ShowTracker
utilization.  Note that in order for all files in the solution to communicate
correctly, the “Show Name” filed must be written in exactly the same fashion.
The Preferences Layout contains basic global settings for the program, i.e.
printing preferences, label preferencs, and unit preferences.

The user can add as many shows— records— to (1) Show Information as
desired, but the rest of the files in the solution must consistently be one of those
choices; in other words, the user cannot use a (3) Mult Detail with Show Name 2
and (9) Console Settings with Show Name 4 within the same directory.  We are
not entirely sure why anyone would ever do that, but don’t.

GETTING STARTED

To begin work on a new show, start with a copy of the Master ShowTracker file,
as discussed in a previous section.  If there is existing data in the associated files,
that is okay; an option will be given to delete those records later.

From the Main Menu of (1) Show Information, click the [NEW SHOW] button.
Instructions will appear at the top of the Entry Layout— the user should enter as
much data into the fields as possible.  The more staff that is entered into the
“Staff” section, the more choices will automatically appear in the “Notes From”
field in (7) Sound Notes.  Enter a Show Logo using the “import picture” button,
illustrated below:

When all information is entered in the Entry Layout, click the [CONTINUE]
button in the Status Area or press [ENTER] to continue.  The Preferences Menu is
displayed, allowing the user to set certain global preferences, including paper
size defaults and printing defaults.  Macintosh OS X users please note that at
present some of the paper size scripts do not work properly in OS X.  We are
working on a fix for this.  Preferences are available to indicate which fields will
appear at the header of most generated paperwork lists.

Do not worry about mistakes or blank fields; it is eminently possible to go back
and reenter information or change preferences later.
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When this information is entered, click the [CONTINUE] button in the Status
Area or press [ENTER] to continue.  A dialog box will appear, which looks like
this:

As the message states, this is the place where the user can delete existing records
from all the solution files and update them with the new Show Name.  If the user
select [CANCEL], the user will be required to open every file individually and
verify that the Show Name matches the correct show.  We recommend the [SET
& CLEAR] option.

ShowTracker will return the user to the Main Menu, and it is ready to begin
working with the other files.

THE BUTTONS

   - Displays the Preferences Menu

  - Clones the Solution.
A clone is a set of FileMaker Pro files that have no data
whatsoever.  It is actually recommended that, unless you
really know what you are doing, you never use this option.
I should really disable it.

  - Recovers the Solution.
When FileMaker Pro is force-quit, or crashes with active
files, sometimes the files can become corrupt.  When this
occurs, the best option is to use FileMaker’s “Recover File”
command.  This button will run a Recover for all of the
solution files.  New copies will appear in the ShowTracker
directory appended with “.... Recovered.” You should trash
the non-recovered originals, and then remove the
“Recovered” suffix from the new files, then try again.
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(2) Mult Summary

(2) Mult Summary is dedicated to audio, video, and speaker multicable trunks.
That is all it does.  It does not track individual pairs or circuits of multicable
(that’s what (3) Mult Detail does).  Just the trunks and tails, ma’am.

Audio multicable is designated as “xx pair,” where xx is any of the customarily
available types of audio multicable.  Video multicable is designated as “XKxx,”
where xx is usually three or five video circuits in the video multicable.  Speaker
multicable can be Soca (eight-two-wire Socapex), Veam (eight-two-wire Veam),
or NL8 (four-two-wire Neutrik NL-8 Speakon).  These are the values that are
built into the solution, but the user is free to add to these designations, such as
those required for AC multicable.

Once data has been entered in the file, it can track the multicable order, tails
orders, print checklists, summarys, and labels of all varieties.  Note that the
multicable order is separate from the cable order in that the cable order handles
single-circuit wiring, such as three-wire AC cable or single XLR cables.

GETTING STARTED

To start using (2) Mult Summary, simply open the file and click [ENTRY].  In a
fresh copy of ShowTracker, the file will be completely empty, requiring the user
to create a New Entry, either by using one of the keyboard commands listed
above, or by clicking the [New Entry] button.

A blinking cursor will wait expectantly in the “Letter” field.  It is recommended
that users consider the following naming conventions:

•ShowTracker cannot, at present, properly utilize Japanese characters as
mult letters; a different version of ShowTracker is required for
Japanese support.

•ShowTracker will support any of the 37 symbolic characters available
as part of the ASCII specification, including but not limited to
umlauts (ü), German double-S (ß), or other diacritical markings.

•We recommend that mult letter designations not exceed three (3)
characters, i.e. “MAV” is okay, but not “MAVX.”

• If a user insists upon using numbers in their mult letter designations,
ShowTracker will automatically insert a hyphen in order to
facilitate readability in (3) Mult Detail lists and labels; i.e. “T1”
mult pairs will read “T1-1,” “T1-2,” ad nauseam.

• It is not recommended to end a mult letter in “I.”
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Enter the letter of the first mult you would like to store.  Using the [TAB] key,
enter the next field in the Entry Layout, the “Name” field.  This is designed to be
a more descriptive name for the multicable in question.  Tabbing over to the next
field, we arrive at the “Pair” field.  A pop-up list appears with popular pair
designations.  Either select one from the list or use the [DELETE] key to clear the
value list and enter your own number.  Similarly, another pop-up list appears in
the “Length” field.

the Entry Layout in (2) Mult Summary

Tabbing into the origin/destination box, the user can designate the origin, or
female end, of the multicable.  A pop-up list may appear, but it may be
completely blank; as records are added to the file, the pop-up list will include
other popular origins/destinations that are in the file for added consistency.

In ShowTracker nomenclature, “Block” refers to the multipin connector on the
trunk of the cable, while “Tails” refers to the breakouts/fanouts OR panel-
mounted connectors that are connected to the trunk.  These are separate fields
because it is always possible that the mult trunk terminates at one location
whereas the tails connected to that trunk terminate somewhere else, i.e. in the
case of a trunk whose multipin connector is panel-mounted on a rack, while the
tails loom up to a console.

Tabbing to “Tails Type,” the user is greeted with yet another pop-up menu
listing popular tails and panel configurations.  In ShowTracker nomenclature,
“XLR-F Tails (MDP Panel)” indicate that the multipin connector of the tails
should be panel-mounted (i.e. stek or Middle-Atlantic UCP series) for rack-
mounting.  The developer is again unsure from whence the designation “MDP”
arrived, but for now, it will stick.  A table of preset tail values appears in the
following pages, with some explanation as to their meaning.
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Quantity of Tails is rather self-explanatory.  “Male Block at” and its subsequent
fields are very similar to the “Female” side of things, except they are male.

The “Clips or Ears” field refers to the AMP G-style multipin connector, found
mainly in Broadway sound shops.  One shop still uses the “Forked” latching
system, but the other two use the Wireworks “Broadway Latching System” of
locking connectors.  If you know of what we speak, then you know why this field
exists.

The “Simple” fields are based on an algorithmic calculation that takes the
origin/destination fields, and simplifies them, if it can.  It assumes that if the user
says “console,” the simpler version is “FOH,” or if the user says “Amp Rack
14,” the simpler version really means “Ampland.”  It is used with the Simple
Label layout, to be discussed shortly.

The “Multicable Type” radio buttons are necessary in in determining sorting and
label printing when using (3) Mult Detail, so the user must utilize them.

Below the Basic Information category, there is the Changes/Notes log area,
where the very anal-retentive user can track changes in lengths, tails types, or
whatnot, simply by writing it in.  The developer finds the feature useful only
about every three years, but that’s why it is there.

When all of the first multicable’s information has been entered, the user should
pat him- or herself on the back and have a cookie/cigarette.
Congratulations— first multicable ENTERED!  If we were a large software
corporation beginning with an “M” and ending in “soft,” we might have a
dancing paperclip (or mult clip, in this case) in the corner of your screen
celebrating your achievement.  But we don’t care that much.

Continue along using the “New Entry” and/or “Duplicate” buttons at the top to
construct your multicable system.

LISTS AND SUMMARIES

To view entries in a concise fashion, facilitating editing or printing, there are two
different types of list views available to the user.  The “Concise Summary” layout
only contains the basic information about the mult trunk, while the “Mult
Summary” includes all the other information about tails.  To access these list
views, the user can either select the layout from the Layout Menu, or return to
the Main Menu and click one of the buttons.

  - will display the Concise Summary.

  - will display the Mult Summary.
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PRESET TAIL VALUES AND WHAT THEY MEAN

XLR-F Tails ....... standard tails
XLR-F Tails 8' ....... standard 8' long tails

XLR-F Tails (MDP Panel) ....... standard tails with rack-mounted multipin
XLR-F Stage Box ....... stage box

XLR-F Rack w/ 1M Block ....... rack-mounted box
XLR-F Custom Panel ....... ???

1/4" TRS Male Tails (Pin 2+) ....... as described
1/4" TRS Male Tails (Pin 3+) ....... as described

Custom Video Tails ....... ???
Custom Video Panel ....... ???

XLR-F Rack w/ 1M Block & XLR-M Tails ....... rack-mt box with passthrough M tails
XLR-M Rack w/ 1M Block, Right ....... rack-mt panel, right-justified multipin,

XLR-M Rack w/ 1M Block, Center ....... and male XLRs (or center-
XLR-M Rack w/ 1M Block, Left ....... or left-justified multipin)
XLR-M Rack w/ 1M & 1F Block ....... rack-mt box with 1F passthrough multipin
XLR-M Rack w/ 1M & 2F Block ....... rack-mt box with 2F passthrough multipin
XLR-M Rack w/ 1F & 2M Block ....... rack-mt box with 1F & 1M passthrough multi

Dual XLR-M Rack w/ 1M Block each ....... two discrete rack-mt panels in one
M Block - BNC-M x5 Tails ....... male multipin to male BNC tails

M Block - BNC-M x5 Tails (MDP Panel) ....... male rack-mt multipin to male BNC tails
M Block - BNC-M x3 Tails ....... male multipin to male BNC tails

M Block - BNC-M x3 Tails (MDP Panel) ....... male rack-mt multipin to male BNC tails
M Block - BNC-M x4 Tails ....... male multipin to male BNC tails

M Block - BNC-M x4 Tails (MDP Panel) ....... male rack-mt multipin to male BNC tails
XLR-M Rack w/ 1M Block, Left, with BNC Tails ....... rack-mt panel, left mult, XLR-M, & BNC tails

NL-4 - 2x NL-2 ....... NL-4 “A/B” Y (1x four-wire to 2x two-wire)
NL-8 - 2x NL-4 ....... NL-8 “A/B” Y (1x eight-wire to 2x four-wire)

NL-8 - 2x NL-2, 1x NL-4 ....... NL-8 “A/B/C” W tail
NL-8 - 4x NL-2 ....... NL-8 to 4x two-wire NL-4 connectors

EP-4 M - 2x NL-2 ....... as NL-4, above
EP-5 M - 2x NL-2 ....... as NL-4, for European Meyer
EP-6 M - 3x NL-2 ....... does anyone actually use EP-6?

EP-6 M - 1x NL-4, 1x NL-2 ....... see above
EP-8 M - 2x NL-4 ....... as NL-8, above

EP-8 M - 2x NL-2, 1x NL-4 ....... as NL-8, above
EP-8 M - 4x NL-2 ....... as NL-8, above
Soca M - 4x NL-4 ....... 4x four-wire NL-4 circuits to M Socapex
Soca M - 8x NL-2 ....... 8x two-wire NL-4 circuits to M Socapex

Soca M - 1x NL-4, 6x NL-2 ....... you get the point
Soca M - 2x NL-4, 4x NL-2 ....... see above
Soca M - 3x NL-4, 2x NL-2 ....... see above

Soca M - 4x NL-4 Box ....... 4x four-wire NL-4 circuits IN BOX
Soca M - 8x NL-2 Box ....... see above

Soca M - 1x NL-4, 6x NL-2 Box ....... this gets easier as you keep reading, right?
Soca M - 2x NL-4, 4x NL-2 Box ....... you understand this now
Soca M - 3x NL-4, 2x NL-2 Box ....... yep.

12/37 - 9x NL-4 ....... this is disgusting multicable.
12/37 - 8x NL-4 ....... and no one should ever use it.
12/37 - 7x NL-4 ....... ever.
12/37 - 6x NL-4 ....... ever.
12/37 - 5x NL-4 ....... ever.
12/37 - 4x NL-4 ....... ever.
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the layout menu in (2) Mult Summary

The Concise Summary looks like this:

All but one of the fields are editable, meaning that the user can click into any
record, any field, and modify the contents.  The buttons along the top will sort
according to the adjacent field name, and the other buttons will track “tagged”
records.  The small grey line to the left of the “Mult Letter” field, when clicked,
will send the user back to the standard Entry Layout (one record to a screen).

The “B?” checkbox is not modifiable and merely displays whether the multicable
trunk in question is in a bundle or not.  If no bundle data has been entered in
(4) Cable & Bundles, the field will remain unchecked.

The Mult Summary provides somewhat more information:

Again, the fields are editable, facilitating changes and comparisons.  Clicking on
the “Mult Letter” field, i.e. “FBR,” will send the user back to the Entry Layout
screen.  The buttons to the right of the screen are to track which multicables have
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been checked, pulled, labeled, racked or bundled.  They are soft-buttons, which
means that they are editable and can be tracked in real-time.

Additional layouts are provided for the shop preparation period.  The Mult
Checklist provides a clean way for tails and trunks to be tracked.  Smart
checklist buttons disappear for trunks-with-no-tails, and additional buttons
appear when two sets of tails are ordered:

If the checklist buttons are used in real-time, the Unlabeled button will find all
unlabeled mult and reprint the labels associated with those mults if necessary.

MULTICABLE ORDERS

After entering multicable into ShowTracker, it is possible to print multicable
orders to provide to the shop.  There are three different orders that can be
printed, in two different formats.  The standard orders— Mult Order, Male Tails
Order, and Female Tails Order, are designed to be delivered unto the shop.
They are separated by cable type and length or tails type.

sample of Multicable Order output
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A box of text appears at the end of the order for special instructions or additional
hardware needs; using the Text Entry button on the Main Menu, the user can
stipulate the single line of text that appears at the bottom of the orders or the text
that appears at the end of the document.

Male and Female Tails Orders operate similarly, and the output is much the same:

sample of Male Tails Order output

The other formats available for the printing and displaying of data are the Order
Detail layouts.  The Order Detail versions allow the show crew to identify which
multicable letters are part of what orders, handy if doing master counts of
equipment or identifying random bits of mult.

sample of Female Tails Order Detail output

LABELS, LABELS, AND MORE LABELS

ShowTracker does labels.  It does a lot of them.  It prints labels for the trunk ends
of the mult.  It prints labels for the multipin ends of the tails.  It prints labels for
the multipin panels.  As the name implies, the button labeled Print Labels will
print your labels-- but first there are some options the user can set.  At present,
there are two different label styles, each with two different printing options.
Future incarnations of ShowTracker will probably include even more label styles,
but that is very low on the Developer’s list of Things To Do.
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The Standard label style (top) provides as much information as will fit onto the
label, including cable type, length, origin/destination, name, and letter, while the
Simple label style (bottom) provides only the letter and the origin/destination.
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Doing the math, there are four labels per mult— one for each end of the mult
trunk, and one for each multipin on the tails.  ShowTracker can print each type of
connector together (left side), or all labels for a given mult together (right side).

Clicking on the [DEMO] button in the Main Menu presents the user with the
currently-available label-printing options.  In the middle of the screen, there is
the “It Puts the Text on the Label” Box.  By turning this function on, and entering
a maximum-four-character ID code, all labels will have a unique-to-the-show
identifier.  The theory behind this function is to avoid confusion when building
multiple shows, and/or when the sound shop in question has older shows
coming back at the same time as a new one is building.

When selecting Print Labels, a menu that looks an awful lot like the menu below
will appear, prompting the user to choose which mults should be printed—
leaving the “Letter” field blank and clicking [CONTINUE] (or pressing [ENTER])
will print all labels.  Alternately, use the pull-down menu to select a particular
mult.  To add more specific mults, click [ADD MORE].  Or, tertially alternatively,
select all “Tagged” mults by clicking [TAGGED].

find menu for label printing in (2) Mult Summary

ShowTracker will perform the command after [CONTINUE] is clicked, and will
present you with information as to how many label sheets need to be fed into the
printer.  The user has the option to print, cancel, or preview the labels prior to
printing.  Mult labels are designed for Avery 5160/5260/5960 address labels.

As an added feature, ShowTracker automatically calculates the size of the
multipin connector and will print smaller labels for, for instance, AMP G-1 block
connectors:

automatically resized labels in (2) Mult Summary
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Printing rack labels is just as easy.  Two label styles are available— one which
prints two mult letters to a single label, and one which prints three mult letters to
a single label.

rack label options in (2) Mult Summary

ADDITIONAL FEATURES

The [TAIL = BLOCK] button in the Main Menu of (2) Mult Summary goes
through every record and compares the “Male Block at” with “Male Tails at”,
and  the “Female Block at” with “Female Tails at” fields.  In data revision, it is
occasionally possible to enter the incorrect data or to forget to revise an
additional field.  When ShowTracker finds a mismatched destination, this is
what happens:

Tail = Block Function Dialog Box in (2) Mult Summary

A NOTE: ShowTracker will automatically omit any records that are designated
“SP,” for “Spare,” when printing labels in (2) Mult Summary.
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As the example shows, the “Male Block at” reads “Rack A3A,” whereas the
“Male Tails at” reads “Rack A3I.”  The user can fix this inconsistency, or not.

Users may question why (2) Mult Summary asks for the number of intercom
racks.  The Developer thinks that this is an extremely good question, and if
anyone knows the answer to it, please let us know.  We think it may have had
something to do with calculating how many blank Stek/MDP panel plates were
required for the show, but we are not sure how this is different from simply
entering “2” in “Tail Quantities” when you have to have to sets of tails.  Oh well.

The user should now have a basic grasp of the functions of (2) Mult Summary
and should be able to construct a multicable order for the show.  As the user
becomes more familiar with each file in ShowTracker, hopefully the utilization of
ShowTracker will become simpler, as well.
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(3) Mult Detail

As (2) Mult Summary took care of mult trunks and tails, (3) Mult Detail takes
care of the individual circuits within the multicable, based on definitions the user
entered in (2) Mult Summary.  (3) Mult Detail cannot be used without a
foundation created in (2) Mult Summary.

Once data has been entered in the file, it can print labels for all imaginable
possibilities, display a text-based signal flow, or summarize multicable
assignments by rack.

A variety of scripts aids in data-entry, obviating ultra-boring repetitive tasks as
much as possible.

GETTING STARTED

After having entered multicable information in (2) Mult Summary, one would
hope that the user has gleaned some insight into how ShowTracker works.
(3) Mult Detail works in a very similar fashion.

Upon opening (3) Mult Detail, simply click [ENTRY].  Once there are more than
zero records, creating mult pair assignments will get easier, but, as is often the
case, the first time is always a little more painful.  Click [NEW ENTRY] to create
a New Record.  Enter a mult letter designation in the “Letter” field.  Multicable
information referenced from (2) Mult Summary will appear in the middle of the
page to remind the user what the mult in question is destined to do.

After entering the “Mult Letter,” enter the first pair in the “Number” field.  This
is usually the numeral “1.”  The Pair Name follows, then origin and destination.
Currently there is a “From” and “Female at” field in the event that certain types
of cables are actually reversed (in the case of loudspeaker and power multicable,
for instance), but this is a confusing system and may be eliminated from
ShowTracker in the future.

A field labeled “Adaptors” is also included to provide a method to remember
which inline adaptors may be needed for the mult pair in question.  There are
also dual tag checkboxes in (3) Mult Detail.  “Tagging” a record merely marks it
for later reference.  Having two tag possibilities provides even more marking for
later uses.

The user can continue to use the [NEW ENTRY] button to create new records,
but this process may be boring and time-consuming, especially when creating
new records simply to fill up unused pairs of the multicable.  Thus, the [FILL IN
PAIRS] button will continue filling in pairs of the multicable from the point at
which the user left off.
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entry layout in (3) Mult Detail

Another method by which to create records in (3) Mult Detail— at least empty
records— is to use the [MAKE IT!] function in the lower left-hand corner of the
Entry Layout:

Make It! function in the Entry Layout of (3) Mult Detail

A list of all multicables in (2) Mult Summary appears, and the “Detail?” answers
whether or not any (3) Mult Detail records have been created for that particular
mult.  Simply highlighting the mult in question, then clicking [MAKE IT!] will
automatically create the requisite number of empty (3) Mult Detail records, into
which the user can enter data at a later date.  Please note that it is imperative that
a record is highlighted before clicking [MAKE IT!].  No one wants to make it
with nothing, and ShowTracker becomes very upset if attempted.

When the user is entering data into (3) Mult Detail, it is sometimes confusing to
remember personal standards of nomenclature, or ultimate destinations of
multicable.  The Violin 1 microphone may travel through several mults before it
arrives at its final destination, but it may be difficult to remember its other paths
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while entering information.  The Prom Date Reference in the lower right-hand
corner of the Entry Layout is designed to help.  ShowTracker compares the first
two words of your current entry with other entries that already exist in the file,
then displays any matches.  In our example, “Violin 1” is entered in the “Pair
Name” field, and in the Prom Date Reference Box, the following is displayed:

Prom Date Reference Box in Entry Layout, (3) Mult Detail

In this fashion the user can see what other mult pairs are used for this purpose,
aiding in properly sending signals to their respective locations.

OTHER HELPFUL FUNCTIONS

During data-entry, there are some tedious tasks that ShowTracker has
automated.  The [MAKE RETURN MULT] button in the Main Menu will create a
reverse-direction set of mult pair assignments, perfect for insert or effects racks.
The user is prompted to choose original and new mult letter assignments— it is
imperative that the mult trunk intended for the new, return mult is already in
(2) Mult Summary.

The [DUPE-A-MULT] button in the Main Menu simply duplicates the pair
assignment from one mult trunk to another.  Similarly, it is imperative that the
mult trunk intended for the new, duplicated mult already exists in (2) Mult
Summary.

The Source/Destination Menu for [MAKE RETURN MULT] and [DUPE-A-MULT].

Additionally, there are some functions that are best left untouched.  These are:
[DRIVE MULTI 1], [DRIVE MULTI 2], and [DRIVE MULTI 3].  Then there are
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functions that may be rendered obsolete in the next version of ShowTracker— for
example, the [F/M @ = FROM/TO] script.  As we discussed in the previous
section, the “From” and “Female at” fields (and their male counterparts) are
somewhat redundant, and the “Female at” and “Male at” fields may be
abolished soon.  However, all multicable tails labels are printed using the
“Female at” and “Male at” data, so for the time being, it is important that the
data in these fields be correct.  The [F/M @ = FROM/TO] function checks all
records for consistency between “From” and “Female at” (and, of course, the
y–chromosome versions), and will alert the user to errors.  The user can ignore
warnings, change the text in question to whatever is currently in “From,” or
whatever is currently in “Female at.”

LISTS

To view entries in a concise fashion, facilitating editing or printing, there are two
different types of list views available.  The standard List Layout is accessed from
the [LIST] button on the Main Menu or other layouts, and presents the user with
all the information available in Entry, minus the Make It! and Prom Date
Reference boxes.  It is also possible to simply select the List Layout from the
Layout Menu.

List Layout in (3) Mult Detail

All fields— including fields referenced to entries in (2) Mult Summary, i.e. Mult
Name, Mult Type, and Mult Length, are editable.  An assortment of sorting and
organizing tools are available in this layout, including two sets of “Tag”
functions.  Buttons at the extreme left perform three functions: the slender grey
line simply takes the user to the Entry Layout for close-up editing, while the
small red box will omit, or hide, all records in that mult.  The green box will
focus on only the mult being edited.  The “All” button will, as the name implies,
show all records, while the “C” button will clear all data except Mult and Pair
Number from the active record.

The second list option is designed for printability, and not for editing.  The Main
Menu’s [MULT SHEETS] button will generate any or all multicables in one of
two different formats.  First, the user is prompted to find specific mult letters,
leaving the field blank for all records, or select from the two tagged categories in
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(3) Mult Detail (“Tag” or “Tag Tag”) or the one tagged category in (2) Mult
Summary (“(2) Tagged”).

Find Function in (3) Mult Detail

After the user clicks [CONTINUE] to perform the find, a dialog box will appear
asking if the user would prefer the environmentally destructive version or the
environmentally less-destructive version.  The environmentally destructive
version prints one mult letter to a page, while the less-destructive version will
print a continuous list.  Examples are below:

The Environmentally Less Destructive version of Mult Sheets in (3) Mult Detail

The Environmentally Destructive version of Mult Sheets in (3) Mult Detail
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LABELS, LABELS, ETC.

As we have discovered in (2) Mult Summary, ShowTracker does labels.  These
labels are for the multicable tails, usually XLR, BNC, 1/4”, or NL-4 connectors.
In (3) Mult Detail, small, Avery-5167-style labels are the norm, and there are a
variety of different layouts for different applications.

Standard, Simple, and Condensed labels are the normal label types for tails,
although a fourth option, Video Tail Labels, is also available.  The first three can
be printed either by gender, i.e. all male labels followed by all female labels, or
all-to-a-page, male-then-female labels.

       Standard, Female Tails Labels      Standard, All to a Page

        Simple, Female Tails Labels     Simple, All to a Page

   Condensed, Female Tails Labels   Condensed, All to a Page
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The user can decide which format best suits the application.  Standard and
Condensed labels identify origin or destination, while Simple identifies only the
pair name.  Also, the user can choose whether to print all labels together, or
separate them according to gender.

Using either [F TAILS LABELS] or [M TAILS LABELS] buttons on the Main
Menu will perform the label-printing function.  Note that if one of the “all to a
page” label types is selected, it makes no difference whether [F TAILS] or [M
TAILS] is used; the output is exactly the same.

The user will be prompted with a familiar search screen to find specific labels, or
print all of them.

The [VIDEO TAIL LABELS] button on the Main Menu of (3) Mult Detail is
designed for a specific application.  Since BNC tails do not easily lend themselves
to labeling, some users prefer to wrap a standard label around the cable itself just
shy of the connector.  Other users may prefer this option, which utilizes cable tie-
wraps with a “flag.”  The label is merely folded over the flag so that the data
appears on both sides, and the tie-wrap is attached to the cable in question.  Since
this is designed for Video Tails, ShowTracker will prompt the user for
confirmation as to which multicables are used for video purposes.

Video Tail Labels in (3) Mult Detail

Video Tail Labels Confirmation Window in (3) Mult Detail
(also appears in various other functions)
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Other label types exist in the form of the [ICM RACK PANEL], [ICM RACK
PATCH], [MULT RACK PANEL], and [MULT RACK PATCH] functions.  These
scripts were originally designed to work with a specific type of design, but have
been adapated to be as globally useful as possible.

The PANEL labels utilize the same format, which allows a single 5267-style label
to be split in half along the horizontal, permitting the user to use the labels on
patch panels with very little labeling clearance.  With some panels, however, it
may be possible to utilize the Standard label style.  An example of the PANEL
labels, printed two to a tail, appears below:

    
Distro Panel Labels in (3) Mult Detail

The [ICM RACK PANEL] function will prompt the user to confirm which mults
are used for intercom purposes, while the [MULT RACK PANEL] will prompt
the user to confirm which mults are used for audio distribution purposes.

Similarly, labels exist for patch cables at a patch rack.  [ICM RACK PATCH] and
[MULT RACK PATCH] are functions designed to do just that.

  
Distro Patch Labels in (3) Mult Detail

The user is free to use whichever label style he or she prefers for whatever
application, of course; the options presented here are merely suggestions.
Additional formats may appear in the future, as well, to better accommodate the
needs of other users.
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OTHER DATA MANIPULATION FUNCTIONS

On the left-hand side of the Main Menu in (3) Mult Detail, five functions exist
that may or may not be helpful to the user.  [PATCH BY RACK F] will sort the
(3) Mult Detail female tails records by rack; that is, any pair with the same origin
(rack) will appear on one page, which can be useful to use during the shop build.
[PATCH BY RACK M] will do the same thing, but with the male tails.

[PATCH BY RACK F] sorts pairs according to rack in (3) Mult Detail

[PATCH BY RACK M] does the other side

Then there are the textual Patch Flow functions.  These functions are designed to
facilitate tracing of single lines throughout the system; i.e. mult pairs with the
same function.  These functions require a little more input from the user, as
ShowTracker cannot, at present, automatically discern the “mult flow” of the
show, that is to say cannot discern which multicables are first, second, and third
in the signal chain, so a “sort number” needs to be assigned.

Any of the [SIGNAL FLOW] functions will prompt the user to sort the individual
audio, intercom, or video multicable in the order in which they need to appear.
Simply enter a numerical value, from lowest to highest, in the “Sort By” field.  In
this fashion, ShowTracker will know that mult “D” comes before “DD” comes
before “A” et cetera et cetera ad nauseam.

Sorting Entry Form in (3) Mult Detail
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The resulting output of the [SIGNAL FLOW] functions then compares the Mult
Pair name with like entries and produces this:

        Audio Signal Flow Output   Intercom Signal Flow Output

In this fashion, it is somewhat easier to troubleshoot problems by identifying the
exact path the signal is taking along its journey to its final destination.

The user should not feel the need to use, necessarily, all of the functions built into
(3) Mult Detail.  Often times certain functions are based on a one-time need, and
then unceremoniously dumped into ShowTracker.  The key is information
dissemination, and the user should use whatever format is best-suited to the
application.
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(4) Cable & Bundles

(4) Cable & Bundles works together with (2) Mult Summary, and therefore it is
imperative that as much data as possible has been entered into
(2) Mult Summary before proceeding to bundles.  However, it is simple enough
to add additional multicables as the user works with (4) Cable & Bundles.

This file is designed to construct bundles of multicables and single cables, and
track single-circuit cables en masse.  From the data, a cable order can be
constructed, and labels for single-circuit cables that have distinct purposes can be
printed.  In addition, bundle summaries for the shop and bundle checklists for
the preparation period can be viewed and edited.  To begin, the user should
decide whether to create a [NEW BUNDLE], a [NEW CABLE], or simply [ADD
CABLE].

[NEW BUNDLE] will create a set of records comprising a bundle of multicable
and single cables, or a bundle of single cables alone.  [NEW CABLE] will simply
create a record for a single, named cable that is not a multicable and not in a
bundle.  [ADD CABLE] will add a quantity of single, unnamed cables— piles of
XLR cable, AC cable, whatever.  The user can begin the process with any of these
options.

MAKING A BUNDLE

Opting for [NEW BUNDLE] will create a new record— and a warning to that
effect will appear.  The user is instructed to enter only a few details before
proceeding.  Entering ONLY this information ensures data integrity as the rest of
the bundle is constructed.

[NEW BUNDLE] first step in (4) Cable & Bundles

Once [CONTINUE] is clicked, or [ENTER] is pressed, the user can either add an
existing multicable from (2) Mult Summary, accessible via a pull-down menu,
OR add a single cable.  Please note that the multicable and single cable fields are
different fields within the record.  Only ONE field should be filled-in; under no
circumstances should both fields be used in a single record, and in fact if the user
attempts to do this, a nasty error message will appear.
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Adding a Multicable to a Bundle in (4) Cable & Bundles

The user can also choose to tab away from the Multicable Name field and enter a
single-cable in the second field.

Adding a Single Cable to a Bundle in (4) Cable & Bundles

A list of possible cable types exists in the “Cable Type” field, but the user can
also select the last option, “Edit...” and add a cable type not listed in the menu.
Tabbing to “Length” will stipulate the cable length.

A multicable entry will automatically read data from (2) Mult Summary to fill in
the “Male at” and “Female at” designations, but the user will be required to fill
these in manually for a cable entry.  It is important to note that ShowTracker will
attempt to compute the converse of the “Male at” and “Female at” designations,
the “Gender at From” and “Gender at To” fields.  These fields are important for
the shop during the bundling process since they will succinctly indicate which
genders of the cables are bundled at each end.  As long as ONE of the fields “To”
or “From” in the bundle information section match the “To” or “From” fields of
the multicable record, all will be well.  A bad thing would be to select a
multicable whose origin is “Connecticut” and destination “Berlin,” and put it in a
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bundle whose origin is “USA” and destination “Germany,” because
ShowTracker will be unable to reconcile those fields, causing much confusion in
the shop.  If a multicable goes to Front-of-House, and the bundle comes from
Front-of-House, then for the love of god, use the same terminology both times.

Single cables are easier to manipulate, since the “Female at” and “Male at” fields
are user-defined.  As long as one of the fields matches the “Bundle From” and
“Bundle To” fields, the “Gender at” fields should appear correctly, as illustrated
in this illustrative example:

A single cable added to the bundle has consistent and correct “Gender at” fields

The Male end of the Edison cable in the example is at the “Amps” side, which is
the Bundle’s origin, which means that the “Gender at From” is correctly
designated as “Male.”  If, perchance, the designations are incorrect, the user can
select the correct designation manually.  Note that asexual cables, such as NL-4
or BNC cables, will automatically enter “MALE” and “MALE” in these fields.

At the bottom of the Entry Layout is the Prom Date Reference Box.  This works
in a similar fashion to the Prom Date Reference Box in (3) Mult Detail.  The user
can instantly see the existing bundle while adding a new cable, and can also
verify that the “Gender at” fields have been displayed correctly.  Note that no
changes can be made in the Prom Date Reference Box.

Prom Date Reference Box in (4) Cable & Bundles
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Using the “New Entry” button on the Bundle Entry layout, the user can add
more cables to the existing bundle.  The user will note that the “Bundle Name,”
“Bundle To,” and “Bundle From” fields will be automatically copied when a new
entry is created.

There are two ways to create a new bundle with a different name and locations.
The first method is to return to the Main Menu, and use the [NEW BUNDLE]
function again.  However, if the user is already creating bundles in the Bundle
Entry layout, simply creating a New Record and editing the text in the “Bundle
Name” and “Bundle To/From” fields will create a new bundle.

Bundle data manipulation, summaries, and lists will be covered in a later section.

SINGLE CABLES

The [NEW CABLE] function will allow the user to create a single, unbundled
cable.  When the function is selected, a list of existing named cables will appear
(and their corresponding bundle, if applicable), along with a new, empty record,
ready for entry in the “Cable Type” field.

Single Cable Entry in (4) Cable & Bundles

The user can select the cable type, cable length, give the cable a name, and then
specify its origin and destination.  If the user wishes to add more named cables,
simply using -N for a New Record will provide another empty record.  Any
cables entered in this fashion will have labels for identification.

GREAT BALLS OF CABLE

[ADD CABLE] does just that— it adds cable.  Lots of it.  This is the method by
which the user can add piles of extra cable— spares, or cable with indeterminate
uses.  It is the Developer’s most oft-abused command.  Selecting this function
will automatically create a new record (with warning), and the user will be
transported to the Add Quantity layout listing additional cable (if any exists) and
a new record, ready for input.

A NOTE about deleting bundle records: if a bundle record containing a
multicable is deleted, the multicable will still remain in (2) Mult Summary.  If
a bundle record containing a single cable is deleted, the cable will be deleted
forever.
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Add Quantity of Cable Entry in (4) Cable & Bundles

If the user wishes to add more quantities of cable, use the -N command for a
New Record, or to delete, use -E.

DATA-VIEWING FUNCTIONS

Since (4) Cable & Bundles is really in charge of several items— multicables in
bundles, single cables in bundles, single cables all alone, and great huge swaths
of extra cable, there are specific methods to view specific categories, unlike the
handy lists available in (2) Mult Summary or (3) Mult Detail.

Three functions are available for viewing cable— [LOOSE CABLE], [NAMED
CABLE], and [ALL CABLE].  The [LOOSE CABLE] button will display
unbundled single runs of named cable and quantities of additional, unnamed
cable.

Result of [LOOSE CABLE] function: named unbundled cabled, and additional unnamed cable.

[NAMED CABLE] will display unbundled single runs of named cable and any
single cables in bundles.

Result of [NAMED CABLE] function: named unbundled cable, and named cabled in bundles.
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[ALL CABLE] will, as the name implies, display any single-runs of cable:
bundled cables, unbundled named cables, and additional unnamed cable.

All fields are editable in these layouts except for the “Bundle Name” field, which
is locked to prevent accidental errors.

On the bundle side of things, the [BUNDLE LIST] function will display all
bundles in a list format.  It is not recommend to create new bundles in this
layout, but it is optimized for quick viewing and editing of existing bundles.
Note that each record is divided by a line, and contains fields for the single cable
as well as multicable, allowing the user to edit any portion of the cables in the
bundle.

Radio buttons are present to indicate whether the cable in question has been
labeled or indeed bundled.  The [BUNDLE LIST] is the easiest layout in which
the user can utilize these buttons.  To indicate that a cable or multicable within
the bundle is labeled, simply click on the “Cab?” radio button.  If the multicable
is indicated as being labeled in (4) Cable & Bundles, the multicable will retain
this information in (2) Mult Summary.  The “Done?” radio button will mark the
entire bundle as being complete, including transferring bundled information to
(2) Mult Summary if necessary.

Bundle List view in Browse Mode— upper section contains multicable,
 lower section contains single cable.

When displayed in Preview Mode for printing, the Bundle List eliminates some
unnecessary fields and looks like this:

Bundle List view in Preview Mode— easier to read.
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Three other layouts for Bundle viewing exist only in Preview Mode, and are
therefore for printing and distribution rather than for editing.

The [BUNDLE SUMMARY], [BUNDLE SHEETS], and [BUNDLE CHECKLIST]
are forms for bundles, but track information in slightly different ways.  The
Bundle Summary is a list of all the bundle information, the Bundle Checklist is a
list designed to be used during shop preparation, and the Bundle Sheets are
printed one sheet to a bundle for the shop.

The Bundle Summary looks like this:

Bundle Summary output in (4) Cable & Bundles

The Bundle Checklist looks similar, but includes radio to illustrate which
bundles have been labeled and/or completed.  If the “labeled” or “bundled”
button is selected on a multicable, the correct indication will appear in
(2) Mult Summary as well.

Bundle Checklist output in (4) Cable & Bundles

Bundle Sheets are a colossal waste of paper, but they prove invaluable when
setting unbundled piles of cable for the shop to bundle.  One sheet is used per
bundle, with very clear indications as to which ends of the constituent cables
should be bundled together.  A sample is illustrated below:

A NOTE: The user should check off bundles and cables in the [BUNDLE LIST]
layout only.
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Bundle Sheet output in (4) Cable & Bundles
note the homage to the New York City Subway system

The Bundle Sheets, Bundle Summary, and Bundle Checklist layouts will indicate
in a very obvious way if the bundle has been checked off as completed or not.
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CABLE LISTS

Once information is entered into (4) Cable & Bundles, the user can print concise
cable orders for the shop by using either [CABLE ORDER] or [CABLE ORDER
DET].  The former is simply a total count of single cables (multicable is not
counted in the cable order; it is generated from the [MULT ORDER] in (2) Mult
Summary), and the latter includes a description as to how many of each type of
cable are used for bundles or are just free additions.

Before the user prints the cable order, however, the user may want to insert a
body of text that will appear at the beginning of the cable order— sufficient for
explanations and clarifications, or a body of text that will appear at the end of the
cable order, such as a cable-hardware order.  The [FIRST TEXT] and [LAST
TEXT] buttons on the Main Menu will provide fields into which the user can
enter any free-form text.

The top of the standard Cable Order looks like this...

Cable Order output (beginning) in (4) Cable & Bundles

...while the last page looks like this:

Cable Order output (end) in (4) Cable & Bundles
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The [CABLE ORDER DET] function displays the Cable Order Detail.  Much like
the Mult Order Detail or Tails Order Detail, this format displays for the user
which cables are being used for what purpose:

Cable Order Detail output in (4) Cable & Bundles

In this fashion, the engineer or design team can easily add or delete cable based
on these quantities, or verify how many spare cables of each type have been
added to the show.

A third function, the [SPEC CABLE ORDER], is designed to give a cable
breakdown for only a selected group of bundles.  Upon using this function, the
user is prompted with a “Find” window, and the user can select which bundles
should be included in the cable breakdown.  As usual, the user can also select all
“Tagged” bundles.  This is a limited-service function that is only necessary every
once in a while.

Find Window in (4) Cable & Bundles

OTHER FUNCTIONS

(4) Cable & Bundles features an assortment of other functions designed to make
the creation and editing of bundles easier.  From the Main Menu, the user can
access the [DELETE], [RENAME], [UNDONE], [DUPE-A-BUNDLE], [CHANGE
LENGTH], and [STUPID SPECIAL] functions.  These functions are all designed
to be used with actual bundles, not with single cables.
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As the name implies, [DELETE] deletes an existing bundle from the database.
Note that if a bundle is deleted from (4) Cable & Bundles that contains a
multicable, the multicable will remain in (2) Mult Summary until it is deleted
manually in that file.  This is a failsafe option and cannot be disabled.

[RENAME] will take an existing bundle and give it a new name.  Pretty simple,
huh?  Most of these functions will prompt the user with a screen that resembles
the one below:

Rename Bundle function in (4) Cable & Bundles

[CHANGE LENGTH] will take an existing bundle and change its length.  If any
multicables are contained within the bundle, those lengths will be changed as
well, and will modify the record(s) contained in (2) Mult Summary.

[STUPID SPECIAL] simply finds any records marked with the “This is a special
thing you should keep track of” checkbox.

[DUPE-A-BUNDLE] requires a bit more thought, but its function is very much
the same.  The user will be prompted to select the bundle to be duplicated, and
then will be asked for the new bundle name (ShowTracker defaults to the
existing bundle name and a “2”).  The action is performed, and any single cables
in the original bundle are renamed with their original name and a “2.”  However,
if there are any multicables in the original bundle, a special window will open
prompting the user to add or select the proper multicable to be used in the new
bundle.

If the target multicable, i.e. the multicable that has to be added for the new,
duplicated bundle, exists in (2) Mult Summary, the user can simply select it from
the list and continue.  However, if the multicable does not exist, the user will
have to add it to the list before continuing.  The user will be prompted with a
multicolored window.  The upper, blue portion indicates the multicable that
needs to be added to ShowTracker, while the lower, purple portion indicates the
original multicable— the one that is now being duplicated, for the user’s
reference.
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Dupe-a-Bundle Multicable Addition Window in (4) Cable & Bundles

Finally, [UNDONE] simply lists any bundles that are not done in the “Bundle
List” layout.  That is all it does.

LABELS, LABELS, LABELS, AGAIN

(4) Cable & Bundles will of course print labels, as much of ShowTracker is wont
to do.  Two buttons on the Main Menu, [SMALL LABELS] and [LARGE LABELS]
will perform these tasks.  Of course, there are options the user can select as to
label style and label format— standard and simple, all to a page, or each gender
to a page.  These options are accessible via the Main Menu.

The user can also select which types of cables use which size label.  The [SMALL
LABELS] or [LARGE LABELS] function will display a menu in which the user
can check off which cable types should use small labels or large labels.  The user
could, theoretically, make selections that would print both small and large labels
for a particular cable, or no labels at all.

In this window the user can also opt to print only “tagged” records in the file.
Pressing [CONTINUE] will print the label pages in much the same method as
found in (3) Mult Detail or (2) Mult Summary.
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Label Print Menu in (4) Cable & Bundles

Some examples of label output are shown below:

  
Small Label Output in (4) Cable & Bundles

Standard Type, All to a Page                                                     Simple Type, Male Only
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Large Label Output in (4) Cable & Bundles

Standard Type, All to a Page                                           Simple Type, Male Only

That about wraps it up, ha ha, for (4) Cable & Bundles.  In fact that about wraps it up for
all the cable functions in ShowTracker.  Other files in the solution will associate with the
cable files so that, for instance, rear-of-console labels will indicate associated mult pair, or
rack drawings will automatically include patching data for the equipment.  But this is it.
Bid farewell to the cables!  It is time to move on to the other parts of the system.

A NOTE about records in (4) Cable & Bundles:
The “Tag” function works by tagging single cables, single quantities of cable, or an entire
bundle.  It will not tag individual bundle elements.
The “Stupid Special” function will tag single cables, single quantities of cable, or individual
bundle elements, but will not automatically mark the entire bundle.
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(5) Equipment Tracker

(5) Equipment Tracker is a file designed to track all the equipment in the
show— from original bid list through revisions, changes, adds, deletes, repairs,
to a final equipment list.  But I don't really like it right now, and it is due for a
major upgrade, which will take time, so I'm not going to bother writing this yet.
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(6) Equipment Settings

(6) Equipment Settings is designed to aid the user in tracking all sorts of knob
positions, parameters, and patches of important pieces of equipment.  It also
tracks positions of measurement microphones and speaker focus/location.  With
the advent of digital signal processors, some of its functions may be obsolete, but
it never hurts to write things down more than once, right?  It never hurts to write
things down more than once, right?

There are three major modes to (6) Equipment Settings: channel/system
settings, insert/ancillary settings, and reverb/effects settings.  Channel/system
settings tracks, on a per-loudspeaker basis: speaker focus, measurement mic
position, system channel processing settings (i.e. delay, equalization).
Insert/ancillary settings tracks compressor, gate, and equalization processing,
and reverb/effect settings tracks effect processor patches.

After data has been entered, settings layouts exist to provide a graphical
representation of the parameter setting for any number of different pieces of
equipment.

CHANNEL ENTRY

(6) Equipment Settings tracks individual system components, broken down,
usually, by loudspeaker system and often individual parts of the loudspeaker
system.  The user does not need to utilize (6) Equipment Settings on a per-
speaker basis if this is not desired; in such an instance, the user can use
(6) Equipment Settings on a system-output basis, tracking all outputs of the that
require system processing, such as delay or equalization.

For example, if a matrix output is labeled “Underbalcony,” a single record in
(6) Equipment Settings could be devoted to “Underbalcony,” containing
information about delay time and equalizer settings, and maybe a general
reference as to speaker location/focus and which measurement microphone is
associated with that system.

Alternately, with a matrix output labeled “Underbalcony,” the user may want to
store data about each of the nine individual loudspeakers and their positions.
This is simply accomplished by adding a subname in a separate field to
“Underbalcony,” i.e. “Underbalcony A,” “Underbalcony B,” etc.  ONE of these
records is set as the Primary Record for the Underbalcony system, and that one
record will contain the delay and equalization information, so the user does not
need to enter the same information over and over.

Using the [NEW CHAN ENTRY] function on the Main Menu, the user is
presented with a new record in the Channel List.  The user should enter a
channel name (i.e. “Underbalcony”), a sub name, if desired, and most
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importantly, the TYPE of channel entry this is: Parametric, Graphic, or Digital.
From there, the user can enter information as to loudspeaker processor and
amplifier (for unpowered cabinets), and the loudspeaker type itself.  The “Sort #”
field will be discussed in a later section.  Clicking the “Disp?” button will
indicate to ShowTracker that this is the PRIMARY record for this channel.

Channel List window in (6) Equipment Settings

Using the -N command for a New Record, the user can then enter more
channels, either sub-channels or new channels.

Entering additional data for each record is simple.  The user can click the [GO]
button from the Channel List, or from the Main Menu can select [CHANNEL
ENTRY].  The Channel Entry window is shown, into which the user can add
delay and equalization settings, as well as amplifier/processor settings, speaker
location, speaker focus, and associated measurement microphone.

The top portion of the window contains the equalizer settings entry form, which
is obviously different based on whether ”PEQ,” “GEQ,” or “DEQ” is selected.
Underneath the equalizer entry is the processing/amplifier section, where the
user can document what type of equipment is used for the channel in question,
including knob positions of processors/amplifiers, if used.

The lower portion of the window holds physical characteristics about the
loudspeaker: seating level, location, seat/row/aisle, horn orientation, and
loudspeaker orientation.  Below the physical section is the measurement

A NOTE regarding equalizer formats:
The Parametric Equalizer (“PEQ”) layout is based on a Meyer CP-10, with five
filters of adjustable parametric equalization, and two shelving filters.  It is
assumed that this layout can also accommodate most other types of parametric
equalizers.
The Graphic Equalizer (“GEQ”) layout is based on a 31-band one-third octave
equalizer, two shelving filters, gain control, and “range” (i.e. ±6dB, ±12dB)
controls.  It is designed to be compatible with most available types of graphic
equalizers.
The Digital Equalizer (“DEQ”) layout is designed to encompass as many of the
possible parameters available in most digital loudspeaker processor systems.
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microphone section, into which the user can assign the channel in question a
measurement microphone, entering the mic’s location and other pertinent
information, as necessary.  The “This is a Time-Reference Speaker” function has
not been fully implemented as of yet and the Developer cannot quite remember
what it is supposed to do.

Parametric Equalizer Entry in (6) Equipment Settings

Graphic Equalizer Entry in (6) Equipment Settings

Digital Equalizer Entry in (6) Equipment Settings

Knobs and faders play a big part in sound systems, as the user undoubtedly
recognizes, and (6) Equipment Settings facilitates entry in these formats.  In the
Parametric Equalizer Entry, all knob positions can be calculated by analog clock
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positions, although bandwidth and cut/boost can also be entered, based on a
Meyer CP-10, in numerical values.  The “Calculate To:” buttons at the left of the
screen will tell ShowTracker to ignore clock values and use the numerical values
for displaying the knob position, or vice-versa.  In Graphic Equalizer Entry,
faders are represented in integral values.  Parametric Equalizer users can enter
values in numerical form, or perhaps the user will choose to simply save the
settings to a memory card and ignore this function in ShowTracker.

System Channel Processing/Amplifier information, visible on all equalizer entry layouts.

Physical Loudspeaker and Measurement Mic information, visible on all equalizer entry layouts.

After channel information has been entered, the user can print the associated
data via a multitude of different commands.

[PRINT T(D)] will print delay times.  [PRINT AMP SETT] will print amplifier
and loudspeaker processor settings, as long as an “Amplifier Type” is specified
in the entry.  [SPEAKER FOCUS] will print physical loudspeaker information.
[MEASUREMENT MIC] will print mic location information.  [EQ DISPLAY] or
[PARAMETRIC EQ] will print equalizer settings based on equalizer type.

What follows are some samples of the results of these functions.

A NOTE about clock values to our younger users:
Please note that ShowTracker is currently unable to process digital clock values.
An analog clock value must be used, instead.  Analog clocks can be identified by
a circular display with two mechanical pointers, called hands.  One hand is
generally shorter than the other, and signifies the hour, while the longer hand
signifies the minutes within the hour.  In ShowTracker, we ignore the minute
hand and concentrate on the hour hand, which spins around in a clockwise
motion, with 12:00 at the top, 6:00 at the bottom, 3:00 to the right, and 9:00 to the
left.



ShowTracker User Guide - 56 -

Delay Times Output in (6) Equipment Settings

[PRINT T(d)] is pretty self-explanatory.  Three fields per record can be stored,
useful for programmable digital delay lines in which the user may have stored
different times for different uses.

Amplifier Settings in (6) Equipment Settings

Amplifier Settings is also rather self-explanatory.  Levels can be stored both in
numerical values (i.e. dB) or in clock values.  We recommend using both, because
we are a little obsessive-compulsive.

Speaker Focus Output in (6) Equipment Settings

Measurement Microphone List in (6) Equipment Settings
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Note that the text at the top of the Measurement Microphone list can be modified
by using the [TEXT ENTRY] command on the Main Menu.

Using the [DISPLAY EQ SETTINGS] function, the user is prompted for some
information...

I'm still working on this... and the rest of the document.  This is arduous.
Possibly one of the most arduous things I've ever done.  Bleh.


